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Esta guía proporciona información y procedimientos para la instalación del PA 800 Plus
EmpowerTM Driver. PA 800 Plus EmpowerTM Driver permite la adquisición de datos desde un
sistema PA 800 Plus Pharmaceutical Analysis con el software Waters EmpowerTM 3 (FR4).
PA 800 Plus EmpowerTMDriver debe estar instalado en el mismo equipo que el softwareWaters
EmpowerTM.
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Requisitos del sistema operativo
Esta versión de software es compatible con Microsoft Windows 10 de 64 bits. Para conocer
los requisitos del ordenador, consulte la sección: Requisitos del ordenador.

Requisitos del ordenador
El ordenador debe cumplir los requisitos mínimos para el software de Microsoft Windows 10
de 64 bits. Para obtener más información, consulte la documentación suministrada por Waters.

También se necesita un puerto USB libre.

Configuración del controlador validada
Tabla 2-1 Configuración del controlador validada

DetallesElemento

Microsoft Windows 10 Enterprise 2016 LTSBSistema operativo

• Oracle versión cliente 12.1.0.2.0 para 32 bits

• Software Waters EmpowerTM

• National Instruments Driver, versión 19

Software adicional

Mínimo: CPU para Windows 7 o 10 Intel 2 Duo, E6400 a
2,13 GHz

Recomendado: Intel Core 2 Duo, E8400 a 3,0 GHz

CPU

Mínimo: 4 GB
Recomendado: 8 GB

Memoria de acceso aleatorio
(RAM)

Mínimo: 25 GBDisco duro

2 GB para el software Waters EmpowerTMEspacio libre en disco

Mínimo: Resolución de 1024 × 768 (excepto para módulos
LAC/E)

Recomendado: Resolución de 1920 × 1080 para el cliente

Monitor
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Tabla 2-1 Configuración del controlador validada (continuación)

DetallesElemento

Concentrador de 8 puertos serieInterfaces de control
opcionales

1 adaptador Ethernet para conectividad de red
Mínimo: Más de 100 Mbps
Recomendado: 1 Gbps

Adaptadores Ethernet

Software necesario
El software Waters EmpowerTM 3 debe estar instalado. PA 800 Plus EmpowerTM Driver se ha
validado con el software Waters EmpowerTM 3 (FR4).

Durante la evaluación de cliente de acceso anticipado, los clientes evaluaron PA 800 Plus
EmpowerTM Driver y encontraron que era totalmente compatible con el software EmpowerTM

3 (FR2) o superior.

Para funciones adicionales de procesamiento de datos:

• Para realizar cálculos de análisis cualitativos para las aplicaciones SDS-MW y cIEF, se
necesita el software Waters EmpowerTM GPC.

• Para realizar cálculos de farmacopea estándar, como los de resolución o ruido y desviación,
se necesita el software Waters EmpowerTM System Suitability.

Póngase en contacto con un representante de ventas de Waters para adquirir una licencia
para el software correspondiente.

Versión necesaria del firmware de PA 800 Plus
PA 800 Plus EmpowerTM Driver se ha validado en sistemas con las siguientes versiones del
firmware de PA 800 Plus. Consulte Tabla 2-2.

Tabla 2-2 Versiones de firmware validadas de PA 800 Plus

Versión de firmwareSistema PA 800 Plus

10.2.3SistemaPA 800 Plus sin certificación ROHS

10.2.5-RSistemaPA 800 Plus con certificación ROHS

10.3.7-RSistema CESI 8000 Plus

Si el firmware de PA 800 Plus no es una de las versiones validadas, debe actualizarse para
asegurarse de que PA 800 Plus EmpowerTM Driver sea compatible con el software Waters
EmpowerTM y las herramientas de SCIEX utilizadas para realizar una cualificación de
funcionamiento. Consulte Determinar la versión del firmware con el softwareWaters EmpowerTM.
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Determinar la versión de firmware del sistema PA 800 Plus
Determinar la versión del firmware con el software Waters EmpowerTM

1. Abra el software Waters EmpowerTM y, a continuación, haga clic en Run Samples.
2. Seleccione el sistema correcto y haga clic en OK.
3. Haga clic en View > System.

Figura 2-1 Cuadro de diálogo System Information

4. Haga clic en Scan Instruments.
Si en la columna OK? aparece Yes, significa que el controlador se está comunicando
con el módulo LAC/E.

5. Desplácese a la derecha hasta la columna Details.
La versión del firmware se muestra con otros detalles del sistema.

Figura 2-2 Versión de firmware

Si es necesario actualizar el firmware, póngase en contacto con un representante de ventas
de SCIEX.

PA 800 Plus EmpowerTM DriverNotas de la versión
7 / 41RUO-IDV-03-9720-ES-B

Requisitos



Determinar la versión de firmware con el software 32 Karat

1. Abra el software 32 Karat.

2. Seleccione el instrumento correcto para iniciar sesión.

Nota: Asegúrese de que el sistema PA 800 Plus y el controlador se comunican.

Figura 2-3 Ventana del software 32 Karat

3. Haga clic en Control > Instrument Status > View.
4. Desplácese hacia abajo para buscar la versión del firmware.
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Figura 2-4 Versión de firmware

Si es necesario actualizar el firmware, póngase en contacto con un representante de ventas
de SCIEX.
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Comprobar controladores instalados
previamente
1. Determine si está instalado el controlador del software Beckman Coulter PACE MDQ

Control for Waters Empower.

a. Haga clic en Control Panel > Programs and Features.
b. Busque Beckman Coulter PACE MDQ Control for Waters Empower software.

Si está presente, desinstálelo. Consulte Desinstalar el Beckman Coulter PACEMDQ
Control for Waters Empower Software Driver.

2. Determine si está instalada la versión correcta del controlador de software de National
Instruments.

Nota: PA 800 Plus EmpowerTMDriver requiere la versión 19.0 del National Instruments
Software Driver. Si hay otra versión instalada, se debe eliminar.

a. Haga clic en Control Panel > Programs and Features.
b. Busque National Instruments Software.

Si el número de versión no es 19.0 (o no se muestra ningún número de versión),
desinstálelo. Consulte Desinstalar las versiones anteriores del controlador de software
de National Instruments.

Desinstalar el Beckman Coulter PACE MDQ
Control for Waters Empower Software Driver
1. Cierre todos los programas del software Waters EmpowerTM que estén abiertos.

2. Haga clic en Control Panel > Programs and Features.
3. Haga clic en Beckman Coulter PACE MDQ Control for Waters Empower software

y, a continuación, en Uninstall/Change.
Se abre la ventana InstallShield Wizard.

4. Haga clic en Remove y, a continuación, en Next.
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Figura 3-1 Beckman Coulter PACEMDQControl forWaters Empower InstallShield
Wizard

5. En el mensaje que se abre, haga clic en Yes para eliminar todas las funciones.
6. Una vez finalizada la desinstalación, haga clic en Finish para cerrar la ventana

InstallShield Wizard.

7. En el panel de control Program and Features, seleccioneRefresh en el menú contextual
y, a continuación, asegúrese de queBeckman Coulter PACEMDQControl for Waters
Empower software haya desaparecido.
Si el controlador sigue apareciendo en el panel de control, repita el procedimiento para
desinstalar el controlador.

Desinstalar las versiones anteriores del
controlador de software de National Instruments
Nota: PA 800 Plus EmpowerTM Driver requiere la versión 19.0 del National Instruments
Software Driver. Si hay otra versión instalada, se debe eliminar.
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1. Haga clic en Control Panel > Programs and Features.
2. Haga clic en National Instruments Software y, a continuación, haga clic en

Uninstall/Change.
Se abre la ventana National Instruments Software.

3. En función de la versión del controlador instalado, realice una de las siguientes acciones:

• Mantenga presionada las teclasCtrl-Mayús, presione la flecha abajo para seleccionar
todos los elementos de la lista y, a continuación, haga clic en Remove.

Figura 3-2 Cuadro de diálogo National Instruments Software Uninstall

• Haga clic en Remove All.

Figura 3-3 Cuadro de diálogo National Instruments Software Uninstall

4. Una vez finalizada la desinstalación, haga clic en Yes para reiniciar el equipo.
5. Una vez reiniciado el equipo, inicie sesión.
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Instalar PA 800 Plus EmpowerTM Driver
Nota: PA 800 Plus EmpowerTM Driver debe estar instalado en el servidor Citrix si PA 800
Plus EmpowerTM Driver se usa en el entorno Citrix.

1. Inserte el DVD de PA 800 Plus EmpowerTM Driver en la unidad de DVD.

2. Vaya a la carpeta PA 800 Plus Empower Driver V1.3.0 y haga doble clic en setup.exe.
Se abre el cuadro de diálogo Open File - Security Warning.

3. Haga clic en Run.
Se abre PA 800 Plus EmpowerTM Driver InstallShield Wizard.

Figura 3-4 Sciex PA 800 Plus EmpowerTM Driver InstallShield Wizard

4. En la página License Agreement, haga clic en I accept the terms of the license
agreement y, a continuación, en Next.

5. Siga las instrucciones en pantalla para instalar el software. Cuando se le solicite, acepte
los valores predeterminados. Si se muestran advertencias al principio de la instalación,
ignórelas.

Instalar el National Instruments Software Driver
PA 800 Plus EmpowerTM Driver requiere la versión 19.0 del National Instruments Software
Driver.
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1. En el DVD de instalación de PA 800 Plus EmpowerTM Driver, vaya a la carpeta NI-488.2
19.0 Driver y haga doble clic en Install.exe.
Se abre el cuadro de diálogo Open File - Security Warning.

2. Haga clic en Run.
El instalador comprueba los acuerdos de licencia y abre la página siguiente.

Figura 3-5 Asistente de instalación NI Package Manager

3. Haga clic en I accept the above 2 license agreements. y, a continuación, en Next
hasta que se abra la página NI Package Manager.

4. En la lista Additional items you may wish to install, haga clic en NI-488.2 .NET
Language Runtime 17.0.1 for .NET Framework 4.5 y, a continuación, en Next.

PRECAUCIÓN: Posible error de comunicación. Asegúrese de que el componente
NI-488.2 .NET Language Runtime 17.0.1 for .NET Framework 4.5 se haya
seleccionado antes de hacer clic en OK. Si el componente no está instalado, el
módulo LAC/E y el sistema PA 800 Plus no podrán comunicarse.

Nota:De forma predeterminada están seleccionados otros componentes en esta lista.
También son obligatorios y deben permanecer seleccionados.
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Figura 3-6 Componentes necesarios de .NET

5. En la página Agree, haga clic en I accept the above 2 license agreements. y, a
continuación, en Next.

6. En la página siguiente, haga clic en I accept the above 2 license agreements. y, a
continuación, en Next.
La instalación puede tardar unos minutos.
Cuando se realiza la instalación, se muestra un mensaje acerca del NI Update Service.

Figura 3-7 Mensaje NI Update Service

7. Haga clic en No.
8. Si el instalador muestra un mensaje acerca de NI Customer Experience Improvement

Program, haga clic enNo, I do not want to participate in the NI Customer Experience
Improvement Program y, a continuación, en OK.

9. Haga clic en Reboot Now para reiniciar el equipo.
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10. Inicie sesión en el equipo.

Nota: Si se abre un cuadro de diálogo en el que se solicita que se registre el software,
haga clic en Cancel para descartarlo.
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Utilice los siguientes procedimientos para configurar el software Waters EmpowerTM para que
funcione con el sistema PA 800 Plus.

Cambiar las unidades de presión
El software Waters EmpowerTM puede mostrar la presión en psi o milibares. De manera
predeterminada, la unidad de presión son los milibares. Las unidades de presión se pueden
cambiar desde la estación de trabajo LAC/E o el servidor Citrix.

Utilice el siguiente procedimiento para cambiar las unidades.

1. Inicie sesión en el ordenador como usuario con privilegios de administrador.

2. Cierre el software Waters EmpowerTM.

3. Abra la ventana Registry Editor.

a. Haga clic en Start, escriba R y, a continuación, haga clic en Run.
Se abre el cuadro de diálogo Run.

b. Escriba regedit.
c. Haga clic en Yes en el mensaje que aparece.
Se abrirá la ventana Registry Editor.

4. Localice la entrada de registro de las unidades de presión.

a. Haga clic en Edit > Find.
b. (Opcional) Haga clic en la carpetaHK_LOCAL_MACHINE de la estructura en árbol.

Sugerencia: La búsqueda de la entrada es mucho más rápida cuando se ha
seleccionado HK_LOCAL_MACHINE.
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c. En el campo Find what:, escriba PressureUnitPSI y haga clic en Find Next.

Figura 4-1 Cuadro de diálogo Find

La búsqueda puede tardar un tiempo. Cuando se encuentre la clave, se resaltará
en el panel derecho de la ventana Registry Editor.

Figura 4-2 Registry Editor

5. Edite la entrada del registro.
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a. Haga doble clic en PressureUnitPSI.
Se abrirá el cuadro de diálogo Edit DWORD (32-bit) Value.

Figura 4-3 Cuadro de diálogo Edit DWORD (32-bit) Value

b. En el campo Value data, escriba el valor de las unidades y, a continuación, haga
clic en OK.
• 1 para psi
• 0 para mbar

c. Haga clic en File > Exit para guardar los cambios y cerrar la ventana Registry Editor.

Configurar el servidor de adquisición
Nota: Configure el servidor de adquisición en el software Waters EmpowerTM 3 (FR4) antes
de realizar el siguiente procedimiento. Para obtener instrucciones, consulte la documentación
del fabricante incluida con el software.

1. Haga doble clic en el icono Empower del escritorio e inicie sesión como usuario con
privilegios de administrador.

2. En el cuadro de diálogo Waters EmpowerTM software Start, haga clic en Configure the
System.
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Figura 4-4 Cuadro de diálogo Waters EmpowerTM Software Start

Se abre la ventana Configuration Manager.

Nota: La lista de nodos de la siguiente figura reflejará la configuración local del
software Waters EmpowerTM.
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Figura 4-5 Ventana Configuration Manager

3. En la tabla, haga clic con el botón derecho del ratón en el nodo que se va a configurar
y seleccione Properties.
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Figura 4-6 Cuadro de diálogo Node Properties, pestaña General

4. Haga clic en la pestaña Configure DHCP y, a continuación, haga clic en Configure
DHCP.
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Figura 4-7 Pestaña Configure DHCP

Se abre el cuadro de diálogo Waters DHCP Server Configuration.
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Figura 4-8 Cuadro de diálogo Waters DHCP Server Configuration

5. Si el Beckman Coulter PACE MDQ Control for Waters Empower Software Driver se ha
instalado previamente, elimine los instrumentos CE existentes de la lista. Haga clic en
BCPACEMDQ en el cuadro de diálogo y, a continuación, en Remove.

6. Haga clic en Add.
Se abre el cuadro de diálogo Add IP Address.

7. Actualice los campos del cuadro de diálogo de la siguiente manera.

Figura 4-9 Cuadro de diálogo Add IP Address

a. Deje en blanco el campo IP Address. No es necesario para un sistema PA 800
Plus.
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b. Deje en blanco el campo MAC Address. No es necesario y se establece
automáticamente en 00-00-00-00-00-00.

c. Haga clic en Instrument Type y seleccione PA800PLUS en la lista.

d. En el campo Serial Number/Unique Name, escriba 1.
e. Haga clic en OK.
Si se muestra un mensaje acerca de la dirección MAC, descarte el mensaje, escriba
cualquier número en el campo MAC Address y, a continuación, haga clic en OK.

8. Si el Beckman Coulter PACE MDQ Control for Waters Empower Software Driver se ha
instalado previamente, haga clic en la pestaña Instruments.

Figura 4-10 Pestaña Instruments

9. Elimine cualquier instrumento configurado previamente asociado al Beckman Coulter
PACE MDQ Control for Waters Empower Software Driver.
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a. Haga clic en la fila con el instrumento que desea eliminar y, a continuación, haga
clic en Remove Instrument.
Los instrumentos configurados previamente muestran BCPACEMDQ en la columna
Type.

Figura 4-11 Mensaje de confirmación

b. Haga clic en Yes en el mensaje que se muestra y, a continuación, haga clic en Yes
en el mensaje siguiente.

c. Si hay otros instrumentos con BCPACEMDQ en la columna Type, repita el
procedimiento para eliminarlos.

10. Haga clic en OK.
Se cierra el cuadro de diálogo Node Properties.

11. Si se va a conectar un segundo sistema PA 800 Plus al módulo LAC/E, repita este
procedimiento exceptuando el paso 7, en el que debe escribir 2 en el campo Serial
Number/Unique Name.

Nota: Los pasos adicionales necesarios para configurar el segundo sistema PA 800
Plus debe realizarlos un representante del servicio técnico de SCIEX. Póngase en
contacto con el servicio de asistencia técnica de SCIEX en sciex.com/request-support.

Notas de la versiónPA 800 Plus EmpowerTM Driver
RUO-IDV-03-9720-ES-B26 / 41

Configurar el software Waters EmpowerTM

https://sciex.com/request-support


Configurar un nuevo sistema cromatográfico
El software Waters EmpowerTM está diseñado para cromatografía. Por lo tanto, cualquier
instrumento conectado al software se denomina "sistema cromatográfico". El sistema PA 800
Plus debe configurarse como sistema cromatográfico para poder utilizarlo.

1. En la ventana Configuration Manager, haga clic en File > New > Chromatographic
System.

Se abre el asistente New Chromatographic System Wizard.

Figura 4-12 Página Type Entry

2. Haga clic en Create New System y, a continuación, en Next.

Nota: La lista de nodos de la siguiente figura reflejará la configuración local del
software Waters EmpowerTM.
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Figura 4-13 Página Select Server

3. Haga clic en el nodo con el sistema PA 800 Plus y, a continuación, haga clic en Next.
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Figura 4-14 Página System Selection

4. En la listaAvailable Instruments de la izquierda, haga clic en PA800PLUS#1, arrástrelo
a la lista New System Instruments de la derecha y, a continuación, haga clic en Next.

5. Actualice los campos de la página de la siguiente manera.
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Figura 4-15 Página Access Control

a. Share System with Other Network Users: Seleccione esta opción para permitir
que otros usuarios de la red accedan al sistema.

b. Allowed Access: Seleccione los tipos de usuarios a los que se permite acceder al
sistema. Las opciones son Owner Only, Owner and Group(s) y Owner, Group,
and World. Para las dos últimas, seleccione los grupos en la lista Allow Access
to Group(s).

c. Allow Access to Group(s): Seleccione los grupos a los que se permite el acceso
al sistema.

Se debe seleccionar al menos un grupo.

d. Password Protect SystemAccess: Seleccione Password Required para solicitar
una contraseña. En los campos Password y Confirm Password, escriba la
contraseña con un máximo de 30 caracteres.

e. Haga clic en Next.
6. Actualice los campos de la página de la siguiente manera.
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Figura 4-16 Página Name Selection de New Chromatography System Wizard

a. System Name: Escriba el nombre del sistema, con un máximo de 30 caracteres.
El nombre se utiliza en la base de datos de Empower y en la ventana Configuration
Manager.

b. Online: Seleccione esta casilla para poner el nuevo sistema en línea.
c. System Comment: (Opcional) Escriba comentarios u otra información de

identificación del sistema, con un máximo de 250 caracteres.

d. Haga clic en Finish.
e. Si aparece un mensaje acerca de un sistema existente configurado en otro sistema

en línea, haga clic en OK.

Definir las bandejas de tampones y muestras
En el software Waters EmpowerTM, las bandejas de muestras y de tampones del sistema PA
800 Plus se denominan placas o "plates". Las placas deben definirse en el software Waters
EmpowerTM. Para simplificar este proceso, SCIEX proporciona archivos de texto con la
información necesaria que se pueden importar.

1. Inserte el DVD de PA 800 Plus EmpowerTM Driver en la unidad de DVD.
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2. En el cuadro de diálogo Waters EmpowerTM software Start, haga clic en Configure the
System.

Se abre la ventana Configuration Manager.

3. Haga clic en Plate Types para mostrar las placas que ya están definidas.

Figura 4-17 Tipos de placas en la ventana Configuration Manager

4. Cree la placa para la bandeja de tampones.

a. Haga clic con el botón derecho del ratón en la tabla y seleccione Import from Text.
b. Haga clic en Browse y acceda al archivo PA800Plus Buffer Tray.txt del DVD de PA

800 Plus EmpowerTM Driver.

Nota: Si el DVD no está disponible, se incluye una copia del archivo en este
documento. Copie el contenido y péguelo en un archivo de texto. Consulte Archivos
de definición de placas.

c. Escriba PA 800 Plus Buffer Tray en el campo New Plate Type Name y luego haga
clic en OK.
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Figura 4-18 Cuadro de diálogo Import Plate Type From Text File

La bandeja de tampones se añade a la lista de la ventana Configuration Manager .

5. Repita el paso 4 para crear las bandejas de muestras.

• Para la bandeja de muestras de 48 viales, seleccione el archivo PA800Plus Sample
Tray.txt y luego asigne a la placa el nombre PA 800 Plus Sample Tray.

• Para la bandeja de muestras de 96 pocillos, seleccione el archivo PA800Plus 96
Well Sample Tray.txt y luego asigne a la placa el nombre PA 800 Plus 96Well Sample
Tray.

En cuanto a la bandeja de tampones, si el archivo de definición de placas no está
disponible, encontrará una copia en este documento. Consulte Archivos de definición
de placas.

Nota: El archivo de definición de placas para la placa de muestras de 96 pocillos es
para una placa estándar SCIEX de 96 pocillos (ref. 609844). Para utilizar una placa
de 96 pocillos de otro fabricante, haga clic en File > New > Plate Type en la ventana
Configuration Manager y, a continuación, defina la placa de forma manual.

6. Si anteriormente se instaló el Beckman Coulter PACE MDQ Control for Waters
EmpowerTM Software Driver, elimine las placas que se crearon para utilizarlas con ese
controlador. Haga clic con el botón derecho en el número de fila de la placa y seleccione
Delete.

7. (Opcional) Para ver información detallada sobre una placa, haga clic con el botón
derecho en el número de fila de la placa y seleccione Properties.

8. (Opcional) Para eliminar una placa, haga clic con el botón derecho en el número de fila
de la placa y seleccione Delete.
Solo se pueden eliminar las placas agregadas por un usuario. Las placas predefinidas
no se pueden eliminar.
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9. Haga clic en File > Exit para cerrar la ventana Configuration Manager.
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• Si se retira el cable de interfaz GPIB del módulo LAC/E, se perderá la comunicación con
el sistema PA 800 Plus. Conecte el cable de interfaz GPIB y, a continuación, reinicie el
módulo LAC/E.

• En un método de conjunto de muestras, se ignoran todos los valores del campo Injection
Volume. En su lugar, el software Waters EmpowerTM utiliza el parámetro Duration para el
evento de inyección a fin de determinar el volumen de inyección.

• En un Inject Pressure Capillary Fill, se producirá un error si se selecciona sample lid
para las posiciones de la bandeja. En su lugar, seleccione Sample como posición de la
bandeja y establezca el incremento de vial en 1.

Nota: El usuario debe programar un método específico si es necesario volver a un vial.
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En esta sección se incluyen las definiciones de placas para la bandeja de tampones, la bandeja
de muestras y la bandeja de muestras de 96 pocillos de SCIEX. Estas placas deben definirse
en el software Waters EmpowerTM.

Los archivos deben instalarse como parte de la instalación del PA 800 Plus EmpowerTM Driver.

Si faltan y es necesario definir las placas, copie el texto, péguelo en un editor de texto y guarde
el archivo.
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Archivo de definición de placas de la bandeja de
tampones de PA800Plus
Empower Profile for Plate Type: CE Buffer Tray
 Plate Type: XY
 Permanent: No
 Plate Terminology: Plate
 Well Terminology: Well
 Plate Dimensions:
  X: 85.00
  Y: 85.00
  Height: 17.00
 Well Dimensions:
  Top Left Well X Location: 9.00
  Top Left Well Y Location: 9.00
  Well Diameter: 12.00
  Well Depth: 14.00
 Row and Column Dimensions:
  Number of Rows: 6
  Row Spacing: 13.40 mm
  Number of Columns: 6
  Column Spacing: 13.40 mm

 Row and Column Offsets:
  Row Offset Type: None
  Row Offset: 0.00 mm
  ColumnOffset Type: None
  Column Offset: 0.00 mm
 Origin: Bottom Left

 Scheme:
  Referencing: XY
  Horizontal: ABC ...
  Vertical: 123 ...
  Sequential Continuous: Off
  Horizontal First Priority: On
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Archivo de definición de placas de la bandeja de
muestras de PA800Plus
Empower Profile for Plate Type: CE Sample Tray
 Plate Type: XY
 Permanent: No
 Plate Terminology: Plate
 Well Terminology: Well
 Plate Dimensions:
  X: 85.00
  Y: 128.00
  Height: 17.00
 Well Dimensions:
  Top Left Well X Location: 9.00
  Top Left Well Y Location: 17.10
  Well Diameter: 12.00
  Well Depth: 14.00
 Row and Column Dimensions:
  Number of Rows: 8
  Row Spacing: 13.40 mm
  Number of Columns: 6
  Column Spacing: 13.40 mm

 Row and Column Offsets:
  Row Offset Type: None
  Row Offset: 0.00 mm
  ColumnOffset Type: None
  Column Offset: 0.00 mm
 Origin: Bottom Left

 Scheme:
  Referencing: XY
  Horizontal: ABC ...
  Vertical: 123 ...
  Sequential Continuous: Off
  Horizontal First Priority: On
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Archivo de definición de placas de la bandeja de
muestras de 96 pocillos de PA800Plus
Empower Profile for Plate Type: 96-Well Sample Tray
 Plate Type: XY
 Permanent: No
 Plate Terminology: Plate
 Well Terminology: Well
 Plate Dimensions:
  X: 85.00
  Y: 128.00
  Height: 17.00
 Well Dimensions:
  Top Left Well X Location: 11.00
  Top Left Well Y Location: 14.50
  Well Diameter: 6.80
  Well Depth: 14.00
 Row and Column Dimensions:
  Number of Rows: 12
  Row Spacing: 9.00 mm
  Number of Columns: 8
  Column Spacing: 9.00 mm

 Row and Column Offsets:
  Row Offset Type: None
  Row Offset: 0.00 mm
  ColumnOffset Type: None
  Column Offset: 0.00 mm
 Origin: Bottom Left

 Scheme:
  Referencing: XY
  Horizontal: ABC ...
  Vertical: 123 ...
  Sequential Continuous: Off
  Horizontal First Priority: On
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Formación del cliente
• En América del Norte: NA.CustomerTraining@sciex.com

• En Europa: Europe.CustomerTraining@sciex.com

• Fuera de la UE y América del Norte, visite sciex.com/education para obtener información
de contacto.

Centro de aprendizaje en línea
• SCIEX Now Learning Hub

Compra de consumibles
Para realizar un nuevo pedido de consumibles SCIEX en línea, vaya a store.sciex.com. Para
realizar un pedido, utilice el número de cuenta, que se encuentra en el presupuesto, la
confirmación del pedido, o los documentos de envío. Por el momento, la tienda en línea SCIEX
solo está disponible para los EE. UU., el Reino Unido y Alemania, pero se ampliará a otros
países en el futuro. Para los clientes de otros países, póngase en contacto con su representante
SCIEX local.

Soporte SCIEX
SCIEX y sus representantes cuentan con un equipo de especialistas técnicos y de servicio
totalmente cualificados en todo el mundo. Ellos sabrán resolver sus dudas y preguntas sobre
el sistema y cualquier problema técnico que pueda surgir. Para obtener más información, visite
el sitio web de SCIEX en sciex.com o póngase en contacto con nosotros de una de las
siguientes formas:

• sciex.com/contact-us

• sciex.com/request-support
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Ciberseguridad
Para obtener las indicaciones sobre ciberseguridad más recientes para los productos SCIEX,
visite sciex.com/productsecurity.

Documentación
Esta versión del documento sustituye a todas las versiones anteriores de este documento.

Para ver este documento electrónicamente se necesita Adobe Acrobat Reader. Para descargar
la última versión, vaya a https://get.adobe.com/reader.

Para buscar la documentación relacionada con el producto de software, consulte las notas de
la versión o la guía de instalación del software que se suministra con el software.

Para localizar la documentación relacionada con los productos de hardware, consulte el DVD
Customer Reference que se suministra con el sistema o componente.

Las últimas versiones del documento están disponibles en el sitio web de SCIEX, en
sciex.com/customer-documents.

Nota: Para solicitar una versión impresa y gratuita de este documento, póngase en contacto
con sciex.com/contact-us.
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